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This chapter shows how to configure the XEM Receiver on surface to decode the signal from the 

XEM Tool. 

Prior to setting up the XEM Receiver you will have to: 

1.  Complete the Surface equipment hardware setup as described in Chapter 5.  

2.  Prepare the XEM Tool as described in Chapter 6. 

3.  Program the XEM Tool as described in Chapter 7. 
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1. LAUNCH XEM RX 

 

1.  Launch the the XEM Rx (XEM receiver) from the short cut on the desk top. 

Or from,  

 START> Extreme Engineering > XEM>  Rx. 

  

Figure 1 XEM RX launch  



 
Extreme Engineering Operations Manual | XEM Software Decoding Page | 5 

Private. Copyright © Extreme Engineering 2013. Unpublished Work. All rights reserved. 

 

2. The XEM Receiver will appear displaying the Capture Tab. 

 

 

Figure 2 Capture Tab 
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2. CONFIGURATION TAB 

 

1. Click on the configuration Tab. 

 

Figure 3 Configuration Tab 

The Configuration Tab is used to configure the XEM Rx prior to the run.  Specifically to: 

• Load the Configuration file in the XEM Rx; this has to match the Configuration file in the 

XEM. 

• Enable or Disable the Survey to POP up when received from the XEM. 

• Select the Units for the different measurements to be used on files and displays.  

• Set the Qualifiers to flag Survey measurements, which will warn the FST when the 

measurements fall outside the User defined tolerance range. 

• Set the Tool Corrections including the North reference for Magnetometer measurements, 

Drill offset (Tool offset), Gamma Correction factor and the Gamma Computation offset. 
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2.1. LOAD CONFIGURATION FILE 

If this is the first time this XEM Rx is being run or a Down link has been performed.  

2. Click on the Load Configuration File button. 

 

Figure 4 Load Configuration File 
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3. The Load Configuration window will appear: 

 

Figure 5 Select Configuration file 

4. Select ONLY 1 X configuration file; this is the config  the tool will be operating in. 

When the operator first programs the tool, the tool will typically have configuration 1, however if 

the operator has performed a downlink or changed the configuration file setting in the tool using 

XConnect, another Configuration file may have to be selected. 

5. Click on Open. 
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6. Confirm the File Name from the configuration info. The File Name should match the 

configuration loaded in the previous step. 

 

Figure 6 Message and configuration information 

7. The Message info shows: 

- The XEM Signal Carrier Frequency.     

- Number of Bits and the time duration of the Frames. 

o In Figure 6 the Survey has 292 bits and is transmitted in 50 seconds. 
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2.2. SURVEY POPUP 

8. Click on the Survey POP-UP check box. This allows Surveys to POP up in a separate Window 

when received from the Tool. 

 

Figure 7  Survey POPUP window 

9. Click on the Show Survey Window Button. 

 

Figure 8 Survey POP up 

10. Click on Close. 
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2.3.  UNIT EDITOR 

11. Click on the Unit Editor. 

 

Figure 9 Unit Editor Button 

 

12. The Unit Editor  allows the user to define the unit system that will be used in the : 

• Decoded log files.  

• Data sent through WITS. 

• Data on the PTK logs.  

• Information displayed on the XEM Rx including: 

o Data below the Rosebud on the Capture Tab. 

o Data on the Data grid in the Capture Tab. 

o The Gamma Computation Offset in the Configuration Tab.  

o Data on the Survey pop-ups when Surveys are taken. 
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13.  Units are defined for:  

• Depth (Meter or Feet). 

• Temperature (Celsius or Fahrenheit). 

• Pressure (Kpa or psi). 

• Flow (Litres/Minute, Meter3 /Minute, Gallons per Minute). 

• Magnetic Field (Gauss or Nano Tesla). 

 

14. Select the units in the top half of the Unit editor to be used for Files. 

 

Figure 10 Units for Files 
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15. Select the units in the bottom half of the Unit editor. 

 These are used for displays in the Capture Tab and the Gamma Computation offset in the 

Configuration Tab. 

16. Click on OK. 

 

Figure 11 Unit Editor 

17.  Units on the displays will only be updated when new values are received. 
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2.4.  QUALIFIERS 

18. Click on the Qualifiers button. 

 

 

Figure 12 Qualifier Button 

19. The Qualifiers window will appear. 

 

Figure 13 Qualifiers Window 
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20. Click on the “Enable” check boxes for the G Total, M Total, DIP, Inclination, Temperature and 

Dip Angle. 

21. Consult the Coordinator for the specific tolerances to be used on the job. 

22. Recommended tolerances for G Total, M Total and DIP can be calculated as follows: 

I. Reference values for G Total, M Total and DIP for the location are obtained from 

the Schlumberger Survey Tool box. 

II. G Total 

o G Total Max = G Total Reference + 0.0025 

o G Total Min = G Total Reference - 0.0025 

If the G total Reference value is 1.000, the G total Max will be 1.0025 and the G Total 

Min will be 0.9975. 

III.  M Total 

o The M Total Reference value is taken from the Survey Tool Box. 

o  M Total Deviation = M Total Reference +/- 0.003 Gauss.  

IV. DIP Angle 

o The DIP Angle Reference value is taken from the Survey Tool Box. 

o The DIP Angle Deviation from the DIP Angle Reference value is +/- 0.45°. 

23. Type the Min and Max value for the G Total, M total and DIP Angle in the Qualifiers Window. 

 

Figure 14 Qualifiers for G total, M total and DIP Angle 

 

1.0025 

0.9975 
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If the Values fall outside the Tolerances the Survey will be flagged on the capture tab. More 

information on the type of flags is given in the Capture Tab (Section 5). 

24. Enter the Qualifiers for Temperature. 

• The Temperature “High” value flags on the Capture Tab data grid if the Temperature 

exceeds the set value (Normally set at 125°C).  

• The Temperature “Maximum” value flags on the Capture Tab data grid if the Temperature 

exceeds the set value (Normally set at 150°C). 

25. If the Well is Vertical check the Vertical check Box. 

• The Inclination value is flagged when the Inclination exceeds the set value to indicate that 

the well is no longer vertical.  

The Inclination and Temperature qualifiers can be modified according to user preference. 

 

Figure 15 Qualifiers 

NOTE: If the Qualifiers for G total, M total and the DIP Angle fall out of the specified tolerances 

during the job it does not always indicate a Tool or Sensor failure; it could also indicate: 

• That the String may have been moving when the Pumps were switched off. This will affect 

the G Total value; In this case the Survey needs to be retaken. 

• Drill string or External Magnetic interference from the Casing, nearby well or a Fish causing 

interference on the M-Total and DIP Angle values.  

0.9975 

1.0025 

0.003 

0.45° 
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• Magnetic formation or Material in the Mud that may cause the M Total or DIP to fall out of 

tolerance. 

2.5.  TOOL CORRECTIONS 

26. Click on the Drop Down box below the North Reference. 

27. Select the North Reference  from the drop down list: 

• True North. 

• Magnetic North. 

• Grid North. 

 

Figure 16 North Correction reference 

The XEM acquires measurements referenced to the Magnetic North. 

• If the Reference North is Magnetic North no Corrections are required. 

• If the Reference North is True North, Magnetic Declination has to be added. 

• If the Reference North is Grid North, Total Grid Correction has to be added.  

o Total Grid Correction = Magnetic Declination – Grid Convergence. 

o  
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28. Type the value of the correction to be used in the Box with Degrees. 

As an Example 

If the North is referenced to the True North and the Declination is 1.1° (Magnetic North is 

East of True North). 

Type 1.1° in the Box outlined with Red color in Figure 17 North Correction value 

More information on the corrections is given in Chapter 3, Section 3.7. 

 

Figure 17 North Correction value 
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29. Enter the Drill offset in Degrees, This is also known as the tool face offset.  

This is the Angular offset between the Gap Sub Scribe Mark and the Motor Scribe Line 

when looking down hole in a Clockwise direction. 

An explanation of how to measure this Angle is given in Chapter 9.  

It is important to enter the Drill offset before commencing Drilling in a Deviated well; 

there is a potential for the well to be drilled in the wrong direction.  

 

 

Figure 18 Drill Offset 
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30. Type the Gamma Correction Factor.  

The Gamma Corr. factor is used to correct the Gamma ray acquired by the XEM for the effects 

of collar thickness and Mud weight. 

The 07-CALC-0004_MPT-EMT_Tool_Length_calculator spreadsheet is used to calculate the 

Gamma Corr. Factor. 

This factor needs to be calculated in order to have correct Gamma values on Logs. 

 

Figure 19 Gamma Correction Factor 
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31. Enter the Gamma computation offset. This is the distance from the Bit to the Gamma Sensor.  

Depth Data is received through WITs at Bit Depth.  

The Gamma Comp.offset allows the Log to be referenced to the Gamma sensor depth (the 

position at which the Gamma measurements are acquired).  

The 07-CALC-0004_MPT-EMT_Tool_Length_calculator spreadsheet is used to calculate the 

Gamma Comp offset. The calculation is illustrated in Chapter 4. 

 

Figure 20 Gamma Comp. offset 

32. The initializations to start the job in the configuration tab are now complete 
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2.6. DOWN LINK  

33. If this is the initial run or the first time the XEM Rx is being configured for the job, Downlink is not 

required. 

34. The XEM is equipped with a vibration sensor that senses the downlinking pattern from the 

pumps turning on and off or from the rotary table starting and stopping. 

35. Typically you can perform downlink to: 

• Increase the Tool Config Number up  

o Example; change the Config in the tool from Config 1 to Config 2  

• Decrease the Tool configuration  Number Down  

o Example; change the Config in the tool from Config 4 to Config 3 

o There can be up to 8 configurations stored in the Tool. You can downlink to the tool 

to increase or decrease the configuration  

o When downlinking to increase or decrease the config # the current target level will 

not change.  

• Increase the Target Current up 

o Example; change the Target current up from 0.3 to 1 Amps 

• Increase the Target Current up 

o Example; change the Target current up from 3.5 to 2 Amps 

o There are 6 x Power Levels (Target Level settings) currently in the standard version 

of the tool. 

There are 4 steps associated with Down Linking 

STEP -1 Initiate the Downlink 

36. Confirm with the Driller that it is safe to perform the Down link and there are no issues in the 

Zone; The Drill string will have to be picked off Bottom and rotation has to be stopped prior to 

Downlinking Operation. The String will have to be stationary and the Pumps OFF and ON during 

the Downlink Operation. 

37. Click on the Downlink Button. 
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Figure 21 Downlink Button 

38. The Downlink pattern will appear. 

39. Select the Desired Pattern (Config Up, Config Down, Target Current Up, Target current down). 

 

STEP 2 Follow the Timed Pattern 

40. The Pumps have to be OFF in the first sequence. 
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41. Click on “START”. 

 

Figure 22 Down link Pattern 

42. A color-coded timer begins as shown in Figure 24. The timer starts off red in color for Flow Off 

and changes to Green for Flow On. The current position in the timing sequence is highlighted by 

the blue status line (orange arrow). The remaining time for the entire Operation is given below. 

  

Figure 23 Initial Pumps off sequence 

43. The Blue Progress Bar below the Pattern indicates the progress during the Sequence. The Time 

in the Red Bar provides the count down when the Pumps have to be Turned ON. 

44. The Down Link pattern can be stopped and restarted at any time. 
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STEP 3 Confirm the Downlink  

45. The software looks for this header message for 30 minutes from the time the Downlink is 

initiated. 

46. After the user follows the pattern and preforms a successful downlink, the tool will send up a 

status message in the original configuration file setting, the status message will tell the user that 

the tool is now going to start sending data in the new configuration files setting.  The STATUS 

Header message in Figure 25 confirms the Tool has successfully been downlinked to Config 2#. 

 

 

Figure 24 Status Header 

 

Figure 25 Downlinked Confirmed 

NOTE: The status message is the only message that the tool will transmit regardless of bore 

pressure, this means that in any configuration file (even non-safety disabled configuration) the 

2 

Dialog 
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tool will transmit a status update without the need to have the minimum 100 psi across the bore 

pressure /annular pressure sensor. 

The status message is the last message sent from the XEM tool in the old configuration. All 

subsequent transmissions are sent in the new configuration. The configuration on the XEM 

Receiver must be changed to properly decode the new transmissions. 

47. Proceed to the Next Stage if Downlinking is confirmed. 

48. Do not proceed to Step 4 if the downlink is not confirmed. One of following two events has 

occurred: 

a. The downlink was not successful and the XEM tool is continuing to send telemetry data in 

the existing configuration. 

b. The downlink was successful, but the confirmation message was not decoded. 

If the Downlink involves changing to a new configuration where the Frequency is modified, 

click on the FFT tab to display the Tool Frequency. This should match the Frequency in the 

new config.  

 

Figure 26 Current FFT tab 

 

49. If the Downlink change involves a change in the tool power, proceed to step 4 to confirm in the 

Survey or tool face Logging frame that the Power Level settings have been modified to confirm a 

change. 

 

STEP 4 Change the Configuration code 

Tool 

Operating 

at 6HZ 
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50. Load the Configuration file. 

 

Figure 27 Load Configuration File 

51. Load the Configuration file. 

52. Select the Config File  

53. Click “Open” 
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3. SURFACE BOX 

 

1.  Click on the Surface Box Tab. 

 

 Figure 28 Surface Box Tab 

This Surface Box is used to: 

• Check the Firmware Version of the XTR. 

• Confirm the XTR Power Voltages are ok. 

• Put the XEM in Operations Mode. 

• Put the Tool in Test Mode (This functionality is not required with the XEM Rx program). 

• Confirm the Gain applied by the XEM Rx to Amplify the EM signal on surface (The 

troubleshooting utility in the Capture Window is now used for this). 

V0.0.1.27 
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• Set the XEM Rx in Auto Gain Mode or Manual Gain Mode (The Troubleshooting utility in the 

Capture Window is now used for this).  

• Set the Band pass filter settings (The Troubleshooting utility in the Capture Window is now 

used for this). 

 

3.1.  XTR FIRMWARE VERSION 

2. Check the Firmware version of the XTR. 

The XTR should have a Firmware of V0.0.1.27 as illustrated in Figure 29 

 

Figure 29 Firmware Version 

 

 

V0.0.1.27 
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3.2. OPERATION MODE 

3. Confirm the Tool “Working Mode” is in “Operation Mode.” 

4. If the Tool Working mode is displayed as Test Mode click on the “Operation Mode” Button. 

 

 

Figure 30  Operation Mode 

 

 

 

 

 

V0.0.1.27 
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3.3.  SURFACE BOX VOLTAGES 

5. Click on the “Get” Button. 

6. The XTR +12V, -12V and 5V supply Voltages will be displayed. The Box Voltages should be 

within +/- 0.5V of the reference value indicated. 

If the values are out of Range replace the XTR Surface Box. 

 

Figure 31 XEM Receiver Surface Box Voltages 

3.4. GAIN CONTROL 

With the V10 software it is recommended to set the Gains in the Trouble shooting Utility located in 

the Capture Tab. This is explained in Section 4.4 of this Chapter. 

V0.0.1.27 
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3.5. BAND PASS FILTER FREQUENCY SETTING 

With the V10 software it is recommended to adjust the Band Pass filter in the Capture Tab: Trouble 

shooting utility. This is explained in Section 4.4 of this Chapter. 
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4. STAT PAGE TAB 

 

1. Upload the Job Information in the Fields provided. This includes the: 

• XRT#, Client, Rig Name, Well Name, FST and Extreme Job  

2. Upload the Service Type, Checking the box for the particular type of Service being provided.  

The Information appears on the Top bar of the XEM Rx Window making it easy for the Command 

center to identify the Job Information and Service provided. 

 

Figure 32 STAT Page 
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5. CAPTURE TAB 

 

1. Click on the Capture Tab 

 

5.1. DATA GRID 

Data or signals transmitted from the tool are displayed in the data grid shown in the box with red 

outline in Figure 33. 

Figure 33  Editing the Data Grid 
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2. Each Signal has a header, value and time stamp. 

 

Figure 34 Direction & Inclination Signal 

3. In the Figure 34; 

•  The Signal is D&I Inclination. 

• The value is 89.88°. 

• The time is 12:11:16 and the Date is 2013 March 11; this is the time when the value 

displayed was received by the XEM Rx. 
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The arrangement of signals in the data grid can be modified according to user preference.  

4.  Check the “Enable Editing” checkbox.  

Remember to disable this checkbox once you have completed this exercise. 

 

Figure 35 Enable Editing in the Data grid 
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5. If you need to add a Signal to the data grid; 

 Click on the Signal box in the data grid where you need to add the signal. 

6. As an example Annular pressure needs to be added on the signal box labeled A. 

Click on the Signal box with the label “A”. 

 

Figure 36  Capture Screen Signal selection Example 

 

 

 

 

 

 

 

 A 
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7. The Signal Selection box will appear; 

8.  Click on DPG Annular Pressure. 

9. Click OK. 

 

Figure 37 Signal Selection 
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10. The DPG Annular pressure now appears in the signal box with the label “A”. 

 

Figure 38 DPG Annular pressure selected 
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11. Configure all the parameter boxes as required. A typical configuration for a D&I job is indicated 

below. 

 

Figure 39 Capture Screen with parameters 

12. Commonly displayed parameters for a Directional job are as follows: 

• D&I Inclination, Azimuth, G Total, M Total, Mag DIP, Auto Tool face, Tool face 

• Telemetry Configuration File, Telemetry Transmitted power Level, Transmitter Voltage Level 

Tx, Telemetry Amp Hours, Telemetry battery voltage. 

• Class D Measure Load Current, Class D Scale Current, Class D Target Current. 

Gamma and Annular pressure can be added if the measurements are provided. 

 

13. Prior to the run during the bank test it is recommended to retake the Surveys.  
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1. A green color value with a grey color header indicates a properly decoded Signal which falls 

within the tolerances specified in the qualifiers window in the configuration tab. 

G Total 

999.95 

12:22:36 2013-Mar-11 

 

Figure 40 Properly Decoded Signal within qualifier range 

 

2.  A green color value with a red color header indicates a properly decoded signal that falls 

outside the tolerances specified in the qualifiers window in the configuration tab. This could 

indicate a possible failure for a particular sensor or that the qualifiers have been set incorrectly. 

G Total 

995.5 

12:22:36 2013-Mar-11 

 

Figure 10 Properly Decoded value outside qualifier range 

 

3. A red color value with a red color header indicates a poorly decoded signal that also falls 

outside the qualifier range.  If the value is a bad decode the red header can be ignored. 

G Total 

888.1 

12:22:36 2013-Mar-11 

 

Figure 11 Poorly Decoded value outside qualifier range 

4. If the signal was noisy and the Receiver had to apply a correction to decode the signal, the value 

will appear in blue color. 

 

 

 

Figure 12 Corrected value in qualifier range 

G Total 

999.99 

12:22:36 2013-Mar-11 
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5. The Temperature value is flagged yellow when it is between the “High” and “Max” thresholds; 

red when it exceeds the “Max”. 

 

5.2. TEXT LOG WINDOW 

 

Figure 41 Select Text Log 

6. Click on the Text Log Button. 

7. This opens the “Text log” window. 
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8. The Text Log window shows the Decoded parameters and the time stamp at which they are 

updated.  

9. Click on the Auto Scroll Option if you need to keep updating the parameters. The parameters 

can be cleared or erased from the list by clicking on “Clear All’. If required the Parameters can 

be copied by clicking on the “copy all” button. 

 

Figure 42 Text Log  

 

10. Click on the close button to exit the Text log window and to return to the Capture Window. 
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5.3. TROUBLE SHOOTING 

11. On the capture screen click on the “Troubleshoot” button. 

 

 

Figure 43  Troubleshooting Button 
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12. The troubleshooting Window appears displaying a number of parameters in a graphic format. 

13.  A description of each of the graphs is given in Figure 44. 

 

Figure 44 Troubleshooting Window  

A. The FFT (Fast Fourier transform) display shows the tool signal frequency and amplitude. 

The display in Figure 44 shows an XEM operating at 4Hz and having a frequency spread 

from 2.75Hz to 5.25 Hz with a good amplitude. 

B. The filtered data display shows the tool Signal that has been decoded by the XEM Rx; the 

decoded signal should have amplitude of 3V if the Auto gain is in use. 

o If Manual gain is in use: Filtered signal output = Input Signal x Manual Gain. 

C. The Long header correlation (%) display shows the ease with which the Long header can be 

decoded.  The display in Figure 44 shows a confidence value of approximately 40%,  

This number will go up when the XEM Rx will actually decode a long header, the confidence 

should appear as a spike as shown in Figure 45(The Header is 95%).  

A 

B 

C 
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Figure 45 Long Header Correlation 95% 

 

 

Figure 46  Troubleshooting (Repeat) 

D. The Signal to Noise ratio plot compares the signal to noise. This number should be > 6 for 

good decoding. In Figure 44 the SNR is between 13 and 15 indicating good signal quality as 

compared with Noise. 

E. The Gain plot shows the gain applied by the XEM receiver to decode the signal. In the 

Figure 44 below the Gain is 2000. Typically if the Gain < 20,000 the signal can be decoded. 

E 

D 
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F. The Band pass filter settings including the Lower and Upper Frequency limits are set 

automatically by the software based on the configuration file.  When decoding the tool signal, 

the XEM Rx ignores the Frequencies above the Upper frequency limit cutoff and below the 

lower frequency cut off. 

For Example, if the XEM Tool is operating at 4 Hz and 2 cycles per symbol, the symbol rate 

is 2 symbols per second as shown in Figure 47. 

• The low pass frequency will be set at 2.75Hz 

• The high pass frequency will be set at 5.25Hz. 

The Lower and upper frequency values can be fine-tuned making the band narrow in order 

to remove Noise at the edges. 

G. The Configuration File Tab input allows the user to verify the configuration file being used by 

the XEM Rx. 

H.  The Notch filter can be used to spike out or remove a select frequency. This can be done by 

typing the value of the unwanted frequency in the “Frequency” box and clicking the “Enable” 

checkbox. More information on the Notch Filter is given in Chapter 3, Section 2.4  

 

Figure 47 Trouble shooting Window (Repeat) 
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F 
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I. “Gain” allows the Amplifier Gain to be set manually or computed automatically. 

• AUTO GAIN: Leave the Auto Gain box checked; it is preferred to use Auto Gain allowing the 

Receiver to calculate the Gain automatically.  The Output signal is automatically adjusted 

such that it has amplitude of 3V. The Auto Gain computed by the XEM Rx is 2000 in the 

Figure 47. 

• MANUAL GAIN: If it is required to adjust the gain manually; select the desired value of the 

Total Gain to be set from the drop down value. Setting a value > 20,000 for Gain does not 

normally help decode the signal. If Manual gain is in use: 

o Filtered signal output = Input Signal x Manual Gain. 

 

Figure 48 Manual Gain 

J.  The default values for the Header Decode threshold are set at; 

• Not decoding 70%; When the XEM Rx is not decoding Signal from the tool. 

• Decoding 80%; When the XEM Rx is decoding Signal from the tool. 

If it is difficult for the XEM Rx to start decoding the Signal, the “Not decoding” threshold can be 

reduced.  If the XEM Rx keeps locking on to wrong signal the “Not Decoding” threshold can be 

increased. If while Decoding the XEM Rx keeps loosing signal at the end of each frame the 

“Decoding” threshold can be reduced. 

 If while Decoding the XEM Rx locks on to the wrong frames and the signal is clean the 

“Decoding” threshold can be increased. 
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14. Exit the Troubleshooting Window by clicking on the Windows close button “X” to return to the 

Capture Screen. 

5.4. TOOL FACE ROSE BUD 

15. On the XEM capture window locate the Tool face rose bud. 

Figure 49 Tool face Rose Bud 
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16. As an Example In the Rose Bud Below: 

The Last 5 x Tool Face values are seen on the rose bud. 

The Last Tool Face value is 143.2 ° to the Right 

The Blue Letter G in the background indicates that this is Gravity Tool Face.  

 

Figure 50 Tool Face Rose Bud 

 

17. The corrections appear on the Top Left Hand corner of the screen. These are entered in 

the configuration editor. Ensure that these are all updated before the run. 

- True North - Mag Dec: 0.2°     

-  Drill offset : 143.2° 

- Gamma Factor : 5.2 

- Gamma offset: 30 ft 

 

 

30 
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The green Letter M in the background indicates that this is Magnetic Tool Face. 

 

Figure 51 Magnetic tool face 
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5.5. D&I NO RESPONSE 

If the Receiver software receives a signal from the tool but does not get directional information in  

the signal possibly due to an internal communication error in the tool: 

• A red and white banner will appear on the Rose bud stating; “Error: No Response from D&I”. 

• The Signal (Inclination, Azimuth, Tool face) values will be - 8888.00 Deg. 

 

Figure 52 No Response from D&I 

The D&I No error Response is triggered when 

• The Inclination value decoded is > 180°. 

• The tool face or Azimuth values decoded are > 360°. 

• A good Tool signal is received by the receiver; one of the directional values is not updated. 

• 3 x Directional values decoded by the receiver in a consecutive frame are corrected. 
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5.6. WITS DATA 

18.  Data received through WITS is displayed below the Rose Bud. This currently includes:  

• Bit depth, when the bit is; 

o On bottom this box will have black text with a grey background.  

o Off bottom this box will have green text on black background.  

• Hole depth  

• ROP  

• Pump Pressure  

• Surface Torque  

• TPO (Total Pump Output)  

19. The Units for the WITS data can be modified in the configuration TAB.  

 

Figure 53 WITS Data Tab 
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Figure 54 Bit Depth, ROP and Pump pressure received through WITS 

 

20. WITS data will only update once received by the XEM Receiver. 

21. When a Sensor value fails on WITS -8888.0 is  displayed 

22.  If it is required to input additional WITs data into the capture Tab 

Click on the Communication Tab   

23. Click on INPUT. 

 

 

  Figure 55 Communication Tab 
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24. On the COM Input Window Select the WITs Record  from the Window on the Left 

25. Click on >> to move the WITs record to the Right   

26. Update the Time Interval as needed. 

27. Click on OK 

 

Figure 56 WITs COMM parameter Window 

 
28. These selected WITS inputs will now be added to the decoded log file at the interval selected in 

this window. They will also now be available as signals for use on the capture Tab.  
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29.  Click on Capture Tab 

30. Check the  Enable Editing on the Data Grid 

31. Additional WITS data can be added by enabling the Edit box in the Data Grid. 

 

Figure 57 Enable Editing on the Data Grid 
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32. The Desired WITS signal can be selected from the Signal Selection Window .  

 

Figure 58 WITS signal Selection 

 

33. The WITs signal will then be added on the Data Grid in the Capture Tab. 
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5.7. DECODING-STATUS, GAIN, SIGNAL DISPLAY 

34.  “STATUS” below the WITS parameter provides information on the frame that is being received. 

In Figure 60, the “Tool face Logging Frame’ is being received.  The progress bar indicates how 

far the frame has progressed and when the next frame is expected to start 

 

 

Figure 60 Status Bar 

 

 

Figure 59 Status bar on Capture Window 

Tool Face   Logging 
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35. As an Example, In the Window below the Total Gain = 2 x 5 x 10 x 1 =100. 

 

 

Figure 61 Total Gain 

A. The green colored sinusoidal signal curve represents the tool signal. If Auto gain is set, 

the filtered signal will automatically be amplified so that the output filtered voltage has 

amplitude of 3V. 

 

B. The pink boxes around green signal show the signal confidence; For QPSK telemetry the 

higher the Pink box from the bottom of the display window the better the signal quality. 

 

C. The + sign above the signal shows a good quality decode. 

 

 

D. Successive signal decodes are colored red and white so that they can be distinguished 

easily. The “0” denotes a Zero; the X denotes a “1” 

  

A 

B 

C 

D 

High Quality Decode 

Medium Quality Decode 
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5.8.  CONFIG FILE AND CONFIG NUMBER 

36. Identify the Configuration File and the Configuration # at the bottom of the Window Tab. 

 

 

 

 

 

It is important to have the correct configuration File and the correct Configuration# in the XEM Rx 

particularly after downlinking otherwise the XEM Rx will not be able to decode the information from 

the Tool.  

Figure 62 Status bar on Capture Window 

Config File 03-01 13_XEM_DynamX_ATF 5-3 deg_Gamma_QPSK_6Hz_2c_Config_1.V10Cfg 

Config 1 QPSK Freq 6.0 Cycles 2 Auto Gain 
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5.9. DECODING AND WITS INDICATORS 

37. Locate the Decode and WITS update windows at the bottom of the XEM Rx Window. 

38. When the Receiver is decoding data from the tool “D” will appear in white with a black 

background. 

 

 

 

 

 

Figure 63  Decode and WITS Update window 
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39. When the Receiver is getting data through WITs “W” will appear in white with a black 

background. 

 

 

 

 

40. When the Receiver is not getting data through WITs or Not Decoding the letters will appear in 

black crossed out with a white background. 

 

 

 

 

 

 

The Decode status is set to ok (D is black), if more than 65% of the expected signals have been 

decoded in the past 200 seconds. The WITs status is set to ok (W is black) if any single WITs has 

been received in the past 200 seconds. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 65 Receiver Not decoding data and Not getting information through WITS 

Figure 64 Receiver Decoding and receiving data through WITs 
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6.  DATA TAB 

 

1. Click on the Data Tab 

The Data Tab is used ONLY by the Engineering Experts for Analyzing the Decoder Performance.  

 

Figure 66 Data Tab showing Clean Signal 

2. The following graphs are included in the Data Tab  

A. Tool Signal : The tool signal graph has been discussed in Section 5.7 

B. Long Header Correlation (% ): The Long Header correlation  graph has been discussed in 

Section 5.3   

C. Decode Success: shows instances of successfully decoded frames as dots. The Dots are 

colored green (OK), Blue (corrected) and red (Not corrected). 

D. SNR (Signal to Noise Ratio): Shows the Signal to Noise ratio of the frames. 

E. Long Header History: Shows the history of the Long Header correlation in %. 
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F. The Constellation Plot shows how the receiver identifies the phase detection. These can be 

seen as cluster of Dots represented on a Y-X axis Clusters of Dots placed together to 

indicate good signal quality. Dots in a cloudy pattern indicate poor Signal quality. 

 

Figure 67 Constellation Poor Signal    Constellation Good Signal   

G. Eye Diagram Real: This shows a number of Lines:  Lines far away from one another indicate 

good signal quality; Lines close to one another indicate poor signal quality. 

 

 

 

 

 

Figure 68  Good quality Signal                      Eye Diagram Good Signal 

H. The View Log file is used to Load and Play back Receiver Log files if required. 

 

      Figure 69 Play back Log Files 
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7. GRAPHIC SIGNAL TAB 

 

1. Click on the Graphic Signals Tab. 

 

Figure 70 Graphic Signals 

1. This utility allows any signal from the tool to be displayed in a graph. 

2. The Graphs are based on discrete signal values (not time). 

3. Signals can be added by clicking on the desired signal graph. 

 

 

 

 

 

 



 
Extreme Engineering Operations Manual | XEM Software Decoding Page | 66 

Private. Copyright © Extreme Engineering 2013. Unpublished Work. All rights reserved. 

 

8. SIGNALS 

 

1. Click on the Signal Tab 

The list of signals transmitted is displayed with the:  

• Time stamp when the data was received by the XEM Rx 

• Message type (Survey, Tool face Logging) 

• Name of the Signal 

• Tool Name: Node in the probe responsible for acquiring the measurement 

• Value (The value of the signal)  

• Unit used 

• WITS ID 

 

 

Figure 71 Tool Signals 
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9. FFT 

 

The FFT spectrogram provides a historic plot of the Tool signal;  

1. Click on the FFT Tab. 

2. Click on the Update FFT History checkbox 

 

Figure 72 FFT showing a relatively clean signal  

The FFT Tab has 3 x Displays: 

1. Signal Voltage shows the current Tool Signal voltage. 

2. Current FFT showing the current Tool Signal Amplitude over a Range of frequency.  The 

center frequency is at 6Hz in Figure 72. 

3. FFT Spectrogram: shows a historical plot of the Tool signal and noise sources. A strong 

signal has Red color while a weak signal has blue color.  

Section 2.5 in the theory chapter provides guidelines on interpreting the FFT spectrogram. 
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